Microsoft Application Series

Excel 2010 Intermediate

Best STL
- Courses never cancelled: guaranteed
- Last minute rescheduling
- 24 months access to Microsoft trainers
- 12+ months schedule
- UK wide delivery

www.microsofttraining.net
Your Best STL Learning Tools

Welcome to your Best STL training course.
As part of your training, we provide you with the following tools and resources to support and enhance your learning experience.

Thank you for choosing Best STL.

1. In-course handbook
   To guide you through your training while you are on the course.
   Contains unit objectives, exercises and space to write notes.

2. Reference material
   Available online through your delegate account.
   Comprehensive reference material with 100+ pages, containing step-by-step instructions.

3. 12 months access to Microsoft trainers
   Available through online support forum.
   Need help? Our team of Microsoft qualified trainers are on hand to offer advice and support.

4. Delegate account
   Your delegate account gives you access to:
   • Reference material
   • Course exercise files
   • Advice & support forum
   • Rewards programme
   • Promotions & Newsletters

5. Trainer hints and tips
   Hints and tips available online from our Microsoft qualified trainers for:
   • All MS Office applications
   • VBA
   • MS Project
   • MS Visio
   + more

6. Save with Promotions
   Save on further training courses you book with Promotions.
   • 30% off list price (time limited)
   • £50 off list price (blue card discount)

E&OE
Best Training reserves the right to revise this publication and make changes from time to time in its content without notice.
<table>
<thead>
<tr>
<th>Unit 3: Working with Dates</th>
<th>28</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dates and time in Excel</td>
<td>28</td>
</tr>
<tr>
<td>Inserting and formatting dates</td>
<td>29</td>
</tr>
<tr>
<td>Entering date functions</td>
<td>29</td>
</tr>
<tr>
<td>Using dates in formulas</td>
<td>30</td>
</tr>
<tr>
<td>Unit 3 Practice Activity</td>
<td>31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unit 4: Conditional Formulas and Formatting</th>
<th>32</th>
</tr>
</thead>
<tbody>
<tr>
<td>The IF function</td>
<td>32</td>
</tr>
<tr>
<td>Using the Function Library</td>
<td>32</td>
</tr>
<tr>
<td>Manually entering a function</td>
<td>33</td>
</tr>
<tr>
<td>Conditional Formatting</td>
<td>34</td>
</tr>
<tr>
<td>Applying Conditional Formatting</td>
<td>34</td>
</tr>
<tr>
<td>Creating a Conditional Formatting Rule</td>
<td>35</td>
</tr>
<tr>
<td>Removing Conditional Formatting</td>
<td>35</td>
</tr>
<tr>
<td>Using the Manage Rules Option</td>
<td>35</td>
</tr>
<tr>
<td>Unit 4 Practice Activity</td>
<td>36</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unit 5: Working with Tables</th>
<th>37</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is a Table?</td>
<td>37</td>
</tr>
<tr>
<td>Creating Tables</td>
<td>38</td>
</tr>
<tr>
<td>Changing the Table Range</td>
<td>38</td>
</tr>
<tr>
<td>Inserting Table Columns</td>
<td>39</td>
</tr>
<tr>
<td>Inserting Table Rows</td>
<td>39</td>
</tr>
<tr>
<td>Deleting Rows or Columns</td>
<td>40</td>
</tr>
<tr>
<td>Creating a Table Total Row</td>
<td>40</td>
</tr>
<tr>
<td>Sorting and Filtering Tables</td>
<td>41</td>
</tr>
<tr>
<td>Sorting Data in a Table</td>
<td>41</td>
</tr>
<tr>
<td>What is an AutoFilter?</td>
<td>43</td>
</tr>
<tr>
<td>Custom AutoFilters</td>
<td>43</td>
</tr>
<tr>
<td>Removing Filters</td>
<td>44</td>
</tr>
<tr>
<td>Filtering with Wildcard Characters</td>
<td>44</td>
</tr>
<tr>
<td>Using an Advanced Filter</td>
<td>45</td>
</tr>
<tr>
<td>Creating Subtotals</td>
<td>46</td>
</tr>
<tr>
<td>Unit 5 Practice Activity</td>
<td>47</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unit 6: Documenting and Auditing</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>48</td>
</tr>
<tr>
<td>Adding, editing and deleting comments</td>
<td>48</td>
</tr>
<tr>
<td>The Formula Auditing Group</td>
<td>48</td>
</tr>
<tr>
<td>Excel Workbook and Worksheet Protection</td>
<td>50</td>
</tr>
<tr>
<td>Protecting your Worksheets</td>
<td>50</td>
</tr>
<tr>
<td>Unlocking Cells</td>
<td>50</td>
</tr>
<tr>
<td>Unit 6 Practice Activity</td>
<td>51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unit 7: Using Templates</th>
<th>52</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is a Template?</td>
<td>52</td>
</tr>
<tr>
<td>Creating a Workbook from a Template</td>
<td>52</td>
</tr>
<tr>
<td>Creating a Template</td>
<td>52</td>
</tr>
<tr>
<td>Unit 7 Practice Activity</td>
<td>53</td>
</tr>
</tbody>
</table>
**Quick reference: Excel 2010 shortcuts**

<table>
<thead>
<tr>
<th>KEY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+SHIFT+()</td>
<td>Unhides any hidden rows within the selection.</td>
</tr>
<tr>
<td>CTRL+SHIFT+)</td>
<td>Unhides any hidden columns within the selection.</td>
</tr>
<tr>
<td>CTRL+SHIFT+&amp;</td>
<td>Applies the outline border to the selected cells.</td>
</tr>
<tr>
<td>CTRL+SHIFT_-</td>
<td>Removes the outline border from the selected cells.</td>
</tr>
<tr>
<td>CTRL+SHIFT+~</td>
<td>Applies the General number format.</td>
</tr>
<tr>
<td>CTRL+SHIFT+$</td>
<td>Applies the Currency format with two decimal places (negative numbers in parentheses).</td>
</tr>
<tr>
<td>CTRL+SHIFT+%</td>
<td>Applies the Percentage format with no decimal places.</td>
</tr>
<tr>
<td>CTRL+SHIFT+^</td>
<td>Applies the Exponential number format with two decimal places.</td>
</tr>
<tr>
<td>CTRL+SHIFT+#</td>
<td>Applies the Date format with the day, month, and year.</td>
</tr>
<tr>
<td>CTRL+SHIFT+@</td>
<td>Applies the Time format with the hour and minute, and AM or PM.</td>
</tr>
<tr>
<td>CTRL+SHIFT!!</td>
<td>Applies the Number format with two decimal places, thousands separator, and minus sign (-) for negative values.</td>
</tr>
<tr>
<td>CTRL+SHIFT+*</td>
<td>Selects the current region around the active cell (the data area enclosed by blank rows and blank columns). In a PivotTable, it selects the entire PivotTable report.</td>
</tr>
<tr>
<td>CTRL+SHIFT+:</td>
<td>Enters the current time.</td>
</tr>
<tr>
<td>CTRL+SHIFT+:</td>
<td>Copies the value from the cell above the active cell into the cell or the Formula Bar.</td>
</tr>
<tr>
<td>CTRL+SHIFT+* Plus (+)</td>
<td>Displays the Insert dialogue box to insert blank cells.</td>
</tr>
<tr>
<td>CTRL+Minus (-)</td>
<td>Displays the Delete dialogue box to delete the selected cells.</td>
</tr>
<tr>
<td>CTRL-</td>
<td>Enters the current date.</td>
</tr>
<tr>
<td>CTRL+=</td>
<td>Alternates between displaying cell values and displaying formulas in the worksheet.</td>
</tr>
<tr>
<td>CTRL+=</td>
<td>Copies a formula from the cell above the active cell into the cell or the Formula Bar.</td>
</tr>
<tr>
<td>CTRL+1</td>
<td>Displays the Format Cells dialogue box.</td>
</tr>
<tr>
<td>CTRL+2</td>
<td>Applies or removes bold formatting.</td>
</tr>
<tr>
<td>CTRL+3</td>
<td>Applies or removes italic formatting.</td>
</tr>
<tr>
<td>CTRL+4</td>
<td>Applies or removes underlining.</td>
</tr>
<tr>
<td>CTRL+5</td>
<td>Applies or removes strikethrough.</td>
</tr>
<tr>
<td>CTRL+6</td>
<td>Alternates between hiding objects, displaying objects, and displaying placeholders for objects.</td>
</tr>
<tr>
<td>CTRL+8</td>
<td>Displays or hides the outline symbols.</td>
</tr>
<tr>
<td>CTRL+9</td>
<td>Hides the selected rows.</td>
</tr>
<tr>
<td>CTRL+0</td>
<td>Hides the selected columns.</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Selects the entire worksheet. If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a second time selects the current region and its summary rows. Pressing CTRL+A a third time selects the entire worksheet. When the insertion point is to the right of a function name in a formula, displays the Function Arguments dialogue box. CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point is to the right of a function name in a formula.</td>
</tr>
<tr>
<td>CTRL+B</td>
<td>Applies or removes bold formatting.</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copies the selected cells. CTRL+C followed by another CTRL+C displays the Clipboard.</td>
</tr>
<tr>
<td>CTRL+D</td>
<td>Uses the Fill Down command to copy the contents and format of the topmost cell of a selected range into the cells below.</td>
</tr>
<tr>
<td>KEY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Displays the <strong>Find and Replace</strong> dialogue box, with the <strong>Find</strong> tab selected.</td>
</tr>
<tr>
<td></td>
<td>SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last <strong>Find</strong> action.</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+F opens the <strong>Format Cells</strong> dialogue box with the <strong>Font</strong> tab selected.</td>
</tr>
<tr>
<td>CTRL+G</td>
<td>Displays the <strong>Go To</strong> dialogue box.</td>
</tr>
<tr>
<td></td>
<td>F5 also displays this dialogue box.</td>
</tr>
<tr>
<td>CTRL+H</td>
<td>Displays the <strong>Find and Replace</strong> dialogue box, with the <strong>Replace</strong> tab selected.</td>
</tr>
<tr>
<td>CTRL+I</td>
<td>Applies or removes italic formatting.</td>
</tr>
<tr>
<td>CTRL+K</td>
<td>Displays the <strong>Insert Hyperlink</strong> dialogue box for new hyperlinks or the <strong>Edit Hyperlink</strong> dialogue box for selected existing hyperlinks.</td>
</tr>
<tr>
<td>CTRL+N</td>
<td>Creates a new, blank workbook.</td>
</tr>
<tr>
<td>CTRL+O</td>
<td>Displays the <strong>Open</strong> dialogue box to open or find a file.</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+O selects all cells that contain comments.</td>
</tr>
<tr>
<td>CTRL+P</td>
<td>Displays the <strong>Print</strong> dialogue box.</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+P opens the <strong>Format Cells</strong> dialogue box with the <strong>Font</strong> tab selected.</td>
</tr>
<tr>
<td>CTRL+R</td>
<td>Uses the <strong>Fill Right</strong> command to copy the contents and format of the leftmost cell of a selected range into the cells to the right.</td>
</tr>
<tr>
<td>CTRL+S</td>
<td>Saves the active file with its current file name, location, and file format.</td>
</tr>
<tr>
<td>CTRL+T</td>
<td>Displays the <strong>Create Table</strong> dialogue box.</td>
</tr>
<tr>
<td>CTRL+U</td>
<td>Applies or removes underlining.</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+U switches between expanding and collapsing of the formula bar.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Inserts the contents of the Clipboard at the insertion point and replaces any selection. Available only after you have cut or copied an object, text, or cell contents.</td>
</tr>
<tr>
<td></td>
<td>CTRL+ALT+V displays the <strong>Paste Special</strong> dialogue box. Available only after you have cut or copied an object, text, or cell contents on a worksheet or in another program.</td>
</tr>
<tr>
<td>CTRL+W</td>
<td>Closes the selected workbook window.</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cuts the selected cells.</td>
</tr>
<tr>
<td>CTRL+Y</td>
<td>Repeats the last command or action, if possible.</td>
</tr>
<tr>
<td>CTRL+Z</td>
<td>Uses the <strong>Undo</strong> command to reverse the last command or to delete the last entry that you typed.</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+Z uses the <strong>Undo</strong> or <strong>Redo</strong> command to reverse or restore the last automatic correction when AutoCorrect Smart Tags are displayed.</td>
</tr>
</tbody>
</table>

**Function keys**

<table>
<thead>
<tr>
<th>KEY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Displays the <strong>Microsoft Office Excel Help</strong> task pane.</td>
</tr>
<tr>
<td></td>
<td>CTRL+F1 displays or hides the Ribbon, a component of the Microsoft Office Fluent user interface.</td>
</tr>
<tr>
<td></td>
<td>ALT+F1 creates a chart of the data in the current range.</td>
</tr>
<tr>
<td></td>
<td>ALT+SHIFT+F1 inserts a new worksheet.</td>
</tr>
<tr>
<td>F2</td>
<td>Edits the active cell and positions the insertion point at the end of the cell contents. It also moves the insertion point into the Formula Bar when editing in a cell is turned off.</td>
</tr>
<tr>
<td></td>
<td>SHIFT+F2 adds or edits a cell comment.</td>
</tr>
<tr>
<td></td>
<td>CTRL+F2 displays the Print Preview window.</td>
</tr>
<tr>
<td>F3</td>
<td>Displays the <strong>Paste Name</strong> dialogue box.</td>
</tr>
<tr>
<td></td>
<td>SHIFT+F3 displays the <strong>Insert Function</strong> dialogue box.</td>
</tr>
<tr>
<td>F4</td>
<td>Repeats the last command or action, if possible.</td>
</tr>
<tr>
<td></td>
<td>CTRL+F4 closes the selected workbook window.</td>
</tr>
<tr>
<td>F5</td>
<td>Displays the <strong>Go To</strong> dialogue box.</td>
</tr>
<tr>
<td></td>
<td>CTRL+F5 restores the window size of the selected workbook window.</td>
</tr>
<tr>
<td>F6</td>
<td>Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a worksheet that has been split (<strong>View menu</strong>, <strong>Manage This Window</strong>, <strong>Freeze Panes</strong>, <strong>Split Window</strong> command), F6 includes the split panes when switching between panes and the Ribbon area.</td>
</tr>
<tr>
<td></td>
<td>SHIFT+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon.</td>
</tr>
<tr>
<td></td>
<td>CTRL+SHIFT+F6 switches to the next workbook window when more than one workbook window is open.</td>
</tr>
<tr>
<td>F7</td>
<td>Displays the <strong>Spelling</strong> dialogue box to check spelling in the active worksheet or selected range.</td>
</tr>
<tr>
<td></td>
<td>CTRL+F7 performs the <strong>Move</strong> command on the workbook window when it is not maximized. Use the arrow keys to move the window, and when finished press ENTER, or ESC to cancel.</td>
</tr>
<tr>
<td>KEY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| F8   | Turns extend mode on or off. In extend mode, **Extended Selection** appears in the status line, and the arrow keys extend the selection.  
SHIFT+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the arrow keys.  
CTRL+F8 performs the **Size** command (on the **Control** menu for the workbook window) when a workbook is not maximized.  
ALT+F8 displays the **Macro** dialogue box to create, run, edit, or delete a macro. |
| F9   | Calculates all worksheets in all open workbooks.  
SHIFT+F9 calculates the active worksheet.  
CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of whether they have changed since the last calculation.  
CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then calculates all cells in all open workbooks, including cells not marked as needing to be calculated.  
CTRL+F9 minimizes a workbook window to an icon. |
| F10  | Turns key tips on or off.  
SHIFT+F10 displays the shortcut menu for a selected item.  
ALT+SHIFT+F10 displays the menu or message for a smart tag. If more than one smart tag is present, it switches to the next smart tag and displays its menu or message.  
CTRL+F10 maximizes or restores the selected workbook window. |
| F11  | Creates a chart of the data in the current range.  
SHIFT+F11 inserts a new worksheet.  
ALT+F11 opens the Microsoft Visual Basic Editor, in which you can create a macro by using Visual Basic for Applications (VBA). |
| F12  | Displays the **Save As** dialogue box. |

### Other useful shortcut keys

<table>
<thead>
<tr>
<th>KEY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| ARROW KEYS | Move one cell up, down, left, or right in a worksheet.  
CTRL+ARROW KEY moves to the edge of the current data region in a worksheet.  
SHIFT+ARROW KEY extends the selection of cells by one cell.  
CTRL+SHIFT+ARROW KEY extends the selection of cells to the last nonblank cell in the same column or row as the active cell, or if the next cell is blank, extends the selection to the next nonblank cell.  
LEFT ARROW or RIGHT ARROW selects the tab to the left or right when the Ribbon is selected. When a submenu is open or selected, these arrow keys switch between the main menu and the submenu. When a Ribbon tab is selected, these keys navigate the tab buttons.  
DOWN ARROW or UP ARROW selects the next or previous command when a menu or submenu is open.  
When a Ribbon tab is selected, these keys navigate up or down the tab group.  
In a dialogue box, arrow keys move between options in an open drop-down list, or between options in a group of options.  
DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down list. |
| BACKSPACE | Deletes one character to the left in the Formula Bar.  
Also clears the content of the active cell.  
In cell editing mode, it deletes the character to the left of the insertion point. |
| DELETE | Removes the cell contents (data and formulas) from selected cells without affecting cell formats or comments.  
In cell editing mode, it deletes the character to the right of the insertion point. |
| END    | Moves to the cell in the lower-right corner of the window when SCROLL LOCK is turned on.  
Also selects the last command on the menu when a menu or submenu is visible.  
CTRL+END moves to the last cell on a worksheet, in the lowest used row of the rightmost used column. If the cursor is in the formula bar, CTRL+END moves the cursor to the end of the text.  
CTRL+SHIFT+END extends the selection of cells to the last used cell on the worksheet (lower-right corner). If the cursor is in the formula bar, CTRL+SHIFT+END selects all text in the formula bar from the cursor position to the end—this does not affect the height of the formula bar. |
| ENTER  | Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by default).  
In a data form, it moves to the first field in the next record.  
Opens a selected menu (press F10 to activate the menu bar) or performs the action for a selected command.  
In a dialogue box, it performs the action for the default command button in the dialogue box (the button with the bold outline, often the **OK** button).  
ALT+ENTER starts a new line in the same cell.  
CTRL+ENTER fills the selected cell range with the current entry.  
SHIFT+ENTER completes a cell entry and selects the cell above. |
<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC</td>
<td>Cancels an entry in the cell or Formula Bar. Closes an open menu or submenu, dialogue box, or message window. It also closes full screen mode when this mode has been applied, and returns to normal screen mode to display the Ribbon and status bar again.</td>
</tr>
<tr>
<td>HOME</td>
<td>Moves to the beginning of a row in a worksheet. Moves to the cell in the upper-left corner of the window when SCROLL LOCK is turned on. Selects the first command on the menu when a menu or submenu is visible. CTRL+HOME moves to the beginning of a worksheet. CTRL+SHIFT+HOME extends the selection of cells to the beginning of the worksheet.</td>
</tr>
<tr>
<td>PAGE DOWN</td>
<td>Moves one screen down in a worksheet. ALT+PAGE DOWN moves one screen to the right in a worksheet. CTRL+PAGE DOWN moves to the next sheet in a workbook. CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a workbook.</td>
</tr>
<tr>
<td>PAGE UP</td>
<td>Moves one screen up in a worksheet. ALT+PAGE UP moves one screen to the left in a worksheet. CTRL+PAGE UP moves to the previous sheet in a workbook. CTRL+SHIFT+PAGE UP selects the current and previous sheet in a workbook.</td>
</tr>
<tr>
<td>SPACEBAR</td>
<td>In a dialogue box, performs the action for the selected button, or selects or clears a check box. CTRL+SPACEBAR selects an entire column in a worksheet. SHIFT+SPACEBAR selects an entire row in a worksheet. CTRL+SHIFT+SPACEBAR selects the entire worksheet. If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the current region. Pressing CTRL+SHIFT+SPACEBAR a second time selects the current region and its summary rows. Pressing CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet. When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects on a worksheet.</td>
</tr>
<tr>
<td>TAB</td>
<td>Moves one cell to the right in a worksheet. Moves between unlocked cells in a protected worksheet. Moves to the next option or option group in a dialogue box. SHIFT+TAB moves to the previous cell in a worksheet or the previous option in a dialogue box. CTRL+TAB switches to the next tab in dialogue box. CTRL+SHIFT+TAB switches to the previous tab in a dialogue box.</td>
</tr>
</tbody>
</table>

ALT+SPACEBAR displays the Control menu for the Microsoft Office Excel window.
What’s New in Excel 2010
Access the right tools, at the right time

New and improved features can help you be more productive, but only if you can find them when you need them. Like the other Microsoft Office 2010 programs, Excel 2010 includes the Microsoft Office Fluent interface, which consists of a customizable visual system of tools and commands.

Improved ribbon

First introduced in Excel 2007, the ribbon makes it easy for you to find commands and features that were previously buried in complex menus and toolbars. Although you could customize the Quick Access Toolbar in Excel 2007, it wasn’t possible to add your own tabs or groups to the ribbon. In Excel 2010, however, you can create custom tabs and groups and rename or change the order of the built-in tabs and groups.

Microsoft Office Backstage view

Click the File tab to open Backstage view, where you create new files, open existing files, save, send, protect, preview, and print files, set options for Excel, and more.
Improved conditional formatting

Conditional formatting makes it easy to highlight interesting cells or ranges of cells, emphasize unusual values, and visualize data by using data bars, color scales, and icon sets. Excel 2010 includes even greater formatting flexibility:

- **New icon sets** First introduced in Office Excel 2007, icon sets let you display icons for different categories of data, based on whatever threshold you determine. For example, you can use a green up arrow to represent higher values, a yellow sideways arrow to represent middle values, and a red down arrow to represent lower values. In Excel 2010, you have access to more icon sets, including triangles, stars, and boxes. You can also mix and match icons from different sets and more easily hide icons from view—for example, you might choose to show icons only for high profit values and omit them for middle and lower values.

- **More options for data bars** Excel 2010 comes with new formatting options for data bars. You can apply solid fills or borders to the data bar, or set the bar direction from right-to-left instead of left-to-right. In addition, data bars for negative values appear on the opposite side of an axis from positive values, as shown here.

- **Other improvements** When specifying criteria for conditional or data validation rules, it's now possible to refer to values in other worksheets in your workbook.
Improved function accuracy

In response to feedback from the academic, engineering, and scientific communities, Excel 2010 now includes a set of more accurate statistical and other functions. Certain existing functions have also been renamed to better describe what they do.

- **Accuracy improvements** A number of functions have been optimized to improve accuracy. For example, Excel 2010 returns more accurate results for the beta and chi-squared distributions.

- **More consistent functions** Certain statistical functions have been renamed so that they are more consistent with the function definitions of the scientific community and with other function names in Excel. The new function names also more accurately describe their functionality. Workbooks created in earlier versions of Excel will continue to work despite these name changes, because the original functions still exist in a Compatibility category.

Improved filter capabilities

In addition to slicers, which are described earlier in this article, Excel 2010 comes with new features that make it easier to sort and filter data.

- **New search filter** When you filter data in Excel tables, PivotTables, and PivotCharts, you can use a new search box, which helps you to find what you need in long lists. For example, to find a specific product in a catalog that stocks over 100,000 items, start by typing your search term, and relevant items instantly appear in the list. You can narrow the results further by deselecting the items you don't want to see.

- **Filter and sort regardless of location** In an Excel table, table headers replace regular worksheet headers at the top of columns when you scroll down in a long table. AutoFilter buttons now remain visible along with table headers in your table columns, so you can sort and filter data quickly without having to scroll all the way back up to the top of the table.
Customising the Toolbar

To customise the Quick Access Toolbar:

- Click on the small down-pointing arrow at the right of the Quick Access Toolbar.
- Click the More Commands option, to display the Excel Options screen.
To add a button:
Select a command from the list on the left and then click the Add button, the command or option in question will be added to the Quick Access Toolbar when you click OK.

To remove a button:
Select a command from the list on the right (the buttons that are currently on the Quick Access Toolbar) and then click the Remove button, the button in question will be removed from the Quick Access Toolbar when you click OK.

At the far right of the Excel Options screen you will see two arrow buttons.

You can use these arrows to shift the position of buttons currently on the toolbar.

If you click the Reset button near the bottom of the Excel Options screen, the Quick Access Toolbar will be reset to its default configuration.

Finally, you can choose to display the Quick Access Toolbar at the bottom of the Ribbon instead of the top using the Quick Access Toolbar menu.
Excel 2010 Ribbons
The most notable feature of the new Excel 2010 interface is the Ribbon format. By default Excel has seven Ribbons available through tabs. These Ribbons are:

- The Home Ribbon
- The Insert Ribbon
- The Page Layout Ribbon
- The Formulas Ribbon
- The Data Ribbon
- The Review Ribbon
- The View Ribbon

Where do I find…?
Here is where you will find some of the more commonly used features of Excel.

<table>
<thead>
<tr>
<th>I want to…</th>
<th>Ribbon/Button</th>
<th>Group/Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a comment</td>
<td>Review</td>
<td>Comments</td>
</tr>
<tr>
<td>Add numbers using AutoSum</td>
<td>Home or Formulas</td>
<td>Editing Function Library</td>
</tr>
<tr>
<td>Adjust the zoom</td>
<td>View or Use Zoom slider (bottom right of screen)</td>
<td>Zoom</td>
</tr>
<tr>
<td>Apply conditional formatting</td>
<td>Home or Data</td>
<td>Styles</td>
</tr>
<tr>
<td>Change Excel's settings</td>
<td>File tab</td>
<td>Excel Options</td>
</tr>
<tr>
<td>Create a chart</td>
<td>Insert</td>
<td>Charts</td>
</tr>
<tr>
<td>Create a header or footer</td>
<td>Insert</td>
<td>Text</td>
</tr>
<tr>
<td>Create a pivot table</td>
<td>Insert</td>
<td>Pivot Table</td>
</tr>
<tr>
<td>Cut/copy and paste data</td>
<td>Home</td>
<td>Clipboard</td>
</tr>
<tr>
<td>Filter my data</td>
<td>Home or Data</td>
<td>Editing Sort &amp; Filter</td>
</tr>
<tr>
<td>Format numbers in my spreadsheet</td>
<td>Home</td>
<td>Number</td>
</tr>
<tr>
<td>Hide columns or rows</td>
<td>Home</td>
<td>Cells – Format</td>
</tr>
<tr>
<td>Import external data into Excel</td>
<td>Data</td>
<td>Get External Data</td>
</tr>
<tr>
<td>Open a file</td>
<td>File tab</td>
<td>Open</td>
</tr>
<tr>
<td>Print a file</td>
<td>File tab</td>
<td>Print</td>
</tr>
<tr>
<td>Save a file</td>
<td>File tab</td>
<td>Save</td>
</tr>
<tr>
<td>Sort my data</td>
<td>Home or Data</td>
<td>Editing Sort &amp; Filter</td>
</tr>
<tr>
<td>Undo/Redo</td>
<td>Quick Access Toolbar</td>
<td></td>
</tr>
<tr>
<td>Use an Excel formula function</td>
<td>Formulas</td>
<td>Function Library</td>
</tr>
<tr>
<td>Use Page Setup features</td>
<td>Page Layout</td>
<td>Page Setup</td>
</tr>
<tr>
<td>Use Print Preview</td>
<td>File tab</td>
<td>Print</td>
</tr>
</tbody>
</table>
Access Keys
Access keys give you access to the Ribbon. They relate directly to the tabs, commands, and other things that you see on the screen. You use access keys by pressing the ALT key followed by another key or a sequence of other keys.

Contextual Tabs
Certain sets of commands are only relevant when objects of a particular type are being edited. For example, the commands for editing a chart are not relevant until a chart appears in a spreadsheet and the user is focusing on modifying it.

Clicking on a chart causes a contextual tab to appear with ribbon commands used for chart editing (see below). Contextual tabs only appear when they are needed and make it much easier to find and use the commands needed for the operation at hand.
Live Preview

Live Preview is a new technology that shows the results of applying an editing or formatting change as the user moves the pointer over various formatting options presented on a Ribbon.

Themes

The Themes button group allows you to change the colours, fonts, and other visual effects associated with a given Excel 2010 theme. You can find the Themes group on the Page Layout tab.
Unit 1: Working with Large Worksheets

In this unit you will learn how to:

- Adjust the zoom on a spreadsheet
- Use the Freeze Panes feature
- Hide rows or columns of data

Viewing and Organising Spreadsheet Data
It is useful to be familiar with various Excel features that you can use in order to make it easier to view and organise data in larger spreadsheets.

The Zoom Feature
To adjust the zoom:

- Use the **Zoom Slider** switch in the lower right corner of the screen to adjust the zoom

![Zoom Slider](image)

- Go to **View** tab, **Zoom** group

![Zoom Options](image)

- If you have a central wheel on your mouse, hold down **Ctrl** and roll the wheel forward or backward to increase or decrease zoom by 15% at a time.
Using Freeze Panes

To use Freeze Panes, go to the View tab, Window group, Freeze Panes button.

To freeze panes (columns and rows):
- Select the cell that is below the rows you wish to freeze and to the right of the columns you wish to freeze.
- Go to the View tab.
- In the Window group, select Freeze Panes.

To freeze panes (top row only):
- Go to the View tab.
- In the Window group, select Freeze Top Row.

To freeze panes (first column only):
- Go to the View tab.
- In the Window group, select Freeze First Column.

To unfreeze panes (any setting):
- Go to the View tab.
- In the Window group, select Unfreeze Panes.
**Hide rows and columns**

Hiding data serves the purpose of allowing you to temporarily make column or rows from your spreadsheet invisible.

To hide data:
- **Right-click** the row or column header for the row/column you wish to hide
- **Select** Hide from the menu

To unhide data:
- **Highlight rows / columns** either side of the hidden one/s
- **Right-click** and select Unhide from the menu
**Using Automatic Outlining**

Excel’s grouping and outlining features will allow you to collapse a large worksheet to show or print summary data, and to expand the same worksheet to show or modify the details.

You will find these features on the **Data** Ribbon in the **Outline** button group.

![Outline button group](image)

**Automatic outlining** works best with numerical data organised into groups and sub groups by formulas or functions.

To automatically outline a worksheet:
- Select the **Data** tab, and locate the **Outline** group
- Click the **Group** button
- Select **Auto Outline**

![Outline example](image)

- The – and + symbols can be used to collapse or expand sections of data respectively.
- The 1 2 3 buttons can be used to view different levels of detail within the data

To remove the outlining from your worksheet, select the **Data** tab, **Outline** group and select the **Ungroup** drop-down arrow, then **Clear Outline**.

![Clear Outline button](image)
**Grouping Data Manually**
Automatic outlining may not be adequate for worksheets with non numerical values or with no distinctive totals (from formulas or functions).

If automatic outlining does not, or cannot, organise your data in the way you want, you can manually group your data as required.

Please refer to the downloadable reference material for instructions on how to group data manually.

**Printing Large Worksheets**
Printing spreadsheets that are larger than one page often requires adjustment of print settings in order to get a hard copy that paginates in an appropriate fashion.

**Print Titles**
The Print Titles feature allows you to select rows and/or columns which contain labels that you would like repeated at the top and/or left side of each printed page.

To access Print Titles:
- Select the **Page Layout** tab
- Go to the **Page Setup** group
- Click the **Print Titles** button
- Under Print Titles, select the Rows to repeat at the top and/or Columns to repeat at left
- Click OK
Excel worksheets can get very large. In fact, most real worksheets contain too much data to fit on one printed page. To print a large worksheet, you have to break up the data into manageable sections. The point where one contiguous sheet of data is broken into separate pages is called a page break.

To view page breaks:
- Go to the View tab, Workbook Views group, and select the Page Break Preview button.
- You can also access Page Break view by clicking the Page Break Preview button on the right-hand side of the status bar.
- You can drag the blue dotted lines with your mouse to adjust where one page ends and another begins.
Inserting a Page Break
To manually insert a page break:
- Select the header of the column to the right or row below where the page break is to appear
- Right-click on the column or row header
- Select Insert Page Break from the menu

Page breaks can also be inserted from the Page Layout tab, Page Setup group, Insert Break button.

Printing Multiple Sheets
Rather than selecting and printing sheets in the same file individually, multiple sheets can be printed simultaneously.

To print all sheets in a workbook:
- Right-click on the active sheet tab
- Choose Select All Sheets from the menu. This will create a group of sheets.
- Use Ctrl + P then press Enter
- To ungroup sheets, right-click on the sheet tab for the first sheet you selected
- Choose Ungroup Sheets

To print selected sheets from a workbook:
- Click the tab for the first sheet you wish to print
- Hold down the Ctrl key while you click the tabs for the other sheets you want to print.
  This will create a group of sheets.
- Use Ctrl + P then press Enter
- To ungroup sheets, right-click on the sheet tab for the first sheet you selected
- Choose Ungroup Sheets
Unit 1 Practice Activity

1. Open Product sales.xls from the Practice Files folder
2. Freeze all the information in column A and rows 1 through 5. Scroll vertically and horizontally.
3. Hide the 2003 and 2004 sales data.
4. Unhide all the hidden columns.
5. Create an automatic outline of the worksheet, and collapse all columns and rows.
6. Compare your worksheet to the example shown below.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Time Out Tours</td>
<td>F</td>
<td>K</td>
<td>P</td>
<td>U</td>
</tr>
<tr>
<td>2</td>
<td>Average tour sales per representative 2003-2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>2003</td>
<td>2004</td>
<td>2005</td>
<td>2006</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Tour</td>
<td>Total</td>
<td>Total</td>
<td>Total</td>
<td>Total</td>
</tr>
<tr>
<td>47</td>
<td>Total</td>
<td>£850,365</td>
<td>£904,503</td>
<td>£932,592</td>
<td>£1,024,663</td>
</tr>
</tbody>
</table>

7. Experiment with all the outline symbols. Then, show all detail.
8. Remove the Outline.
9. Set print titles so that the company name, subtitle and tour names appear on every page.
10. Adjust the page breaks by using Page Break Preview so that each year’s figures fit on one page each.
11. Save the workbook as My Product sales and close.

Online support forum and knowledge base
http://www.microsofttraining.net/forum
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 2: Working with Multiple Worksheets and Workbooks

In this unit you will learn how to:
- Manage worksheets
- Create 3D formulas
- Use the Consolidate feature to create a summary spreadsheet
- Create and manage links between Excel files

Using Multiple Worksheets
The default number of worksheets in a workbook is three; the maximum number of worksheets is limited only by the memory capacity of your PC.

To create a new worksheet, click the Insert Worksheet tab to the right of the existing sheet tabs in your workbook (or use the shortcut keys Shift + F11).

Right-click on a sheet tab to get to the menu below.

<table>
<thead>
<tr>
<th>Insert</th>
<th>Inserts a sheet tab to the left of the present sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Permanently deletes the sheet, cannot delete if there is only one sheet</td>
</tr>
<tr>
<td>Rename</td>
<td>To display a different name on the sheet tab</td>
</tr>
<tr>
<td>Move or Copy</td>
<td>Move or copy the sheet within the workbook or to a different workbook</td>
</tr>
<tr>
<td>View Code</td>
<td>View the VBA code in any modules in the workbook</td>
</tr>
<tr>
<td>Protect Sheet</td>
<td>Apply protection to the worksheet</td>
</tr>
<tr>
<td>Tab Colour</td>
<td>Apply colour to the sheet tab</td>
</tr>
<tr>
<td>Hide</td>
<td>Temporarily hide the worksheet from view (using Unhide will reverse this)</td>
</tr>
<tr>
<td>Select All Sheets</td>
<td>Creates a group which includes all worksheets in the workbook (using Ungroup Sheets will reverse this)</td>
</tr>
</tbody>
</table>
Navigating between sheets
The navigation buttons to the left of the sheet tabs are used to assist with viewing sheet tabs.

The following shortcut keys are also useful:
- **Ctrl + Page Down** Make the next tab to the **right** active
- **Ctrl + Page Up** Make the next tab to the **left** active

Creating 3-D formulas
Instead of calculating with only rows and columns on a *single* sheet, we can create formulas that reference cells on *multiple* sheets.
A reference that refers to the *same cell or cell range* on multiple sheets is called a 3-D reference.

To create a 3-D formula using a function:
- Select the cell where the formula is to be entered
- Type `=` (equal sign)
- Type in the function name (e.g. `SUM`) followed by an open bracket
- Click on the sheet tab of the first worksheet to be entered into the formula
- Hold down the **Shift** key and click on the sheet tab for the last worksheet to be entered into the formula
- On the sheet you have just selected, highlight the cell or range of cells to be included in the formula
- To complete the formula, and press the **Enter** key
Consolidating data
When you consolidate worksheets, you are combining, condensing, and summarising data from multiple sheets into one sheet. For example, a large company may have sales or profit data broken down into several different geographical locations. Each worksheet would have the same layout and structure (template) but contain different data.

To consolidate worksheets:
- Open the relevant workbook.
- Select a destination sheet where the data will be consolidated. It is a good idea to set up the destination worksheet to be just like the worksheets that will supply the data. This means having the same labels and using the same layout and cell locations for the same types of data.
- Select the cell at the upper left of the range that will contain the consolidated data.
- Select the Data Ribbon, and click the Consolidate button.

  ![Consolidate Button]

- Under the word Function, select the function you wish to use to combine the data.
- The text field under the word Reference is where you enter the ranges of data to be consolidated. Select the ranges from the different worksheets with your mouse or keyboard.
- When a range is entered, click the Add button to add it to the All References field.
- Check the “Use labels in” boxes to consolidate sheets based on row labels or column labels.
- Check the “Create links to source data” if you wish to have the consolidated data updated.
- Once all options are set, make sure the worksheets and cell ranges to be consolidated are correct, and click OK.

The worksheets will be consolidated and combined into the destination worksheet.
Linking your workbooks
To properly manage your workbooks, you should be able to combine or consolidate data from more than one workbook or worksheet. By doing this, you can provide a clear and unified picture of data that may be spread over multiple sources.

Linking Workbooks
A cell reference like K7 simply refers to the cell at the intersection of column K and row 7. A cell reference like Store!K7 refers to the cell at column K and row 7 in the worksheet named Store. Taking this one step further, the reference [Sales.xlsx]Store!K7 refers to cell K7 in worksheet Store in the workbook Sales.

In Excel, a cell in one worksheet can contain a reference to a cell in another worksheet or in another workbook. This kind of linking can be useful if you have several sheets that have to reference the same pool of data. If you create links, the linked cells in the other worksheets or workbooks will be updated automatically when you update the source data.

Using the Paste Link option
To link two workbooks:
- Open both workbooks and select the cell or range of source data that you want to use from one workbook.
- Right click on the cell or range and select Copy from the menu.
- Right click on the cell in the destination workbook that will contain the linked data. (If you are linking a range of data, right click on the top left cell of the destination range.)
- Select Paste Special from the pop up menu
- Click on the Paste Link button in the lower left corner of the Paste Special dialogue box.
- The linked data will now appear in the destination workbook. If you update the source data, the linked data will be updated as well.

Creating a formula to link workbooks
There is also another way to create links between workbooks – by creating a formula.
- Click on the destination cell and press the = key
- Click the source data cell in another workbook
- Press the Enter key.
- The two workbooks should now be linked, and any data or changes that appear in the source cell will be seen in the linked cell as well.
**Controlling link updates**

When the source workbook and the destination workbook are open on the same computer, links are updated automatically. When you open a destination workbook, and the source workbook is not open, you may be alerted by the Trust Bar (see below) whether to update the links.

You can control whether the Trust Bar alerts you, and whether to update all links when the alert does not appear. You can also update only some of the links, if the workbook contains more than one link.

**Manually update all of the links or none of the links in a workbook**

Close all workbooks. If one source workbook is open, and others are closed, the updates will not be uniform. Open the workbook that contains the links. To update the links, on the Trust Bar, click *Enable this Content*. 
Manually update only some of the links to other workbooks
Close all workbooks. Open the workbook that contains the links.
On the Data tab, in the Connections group, click Edit Links.

In the Source list, click the linked object that you want to update.
  - To select multiple links, hold down CTRL and click each linked object.
  - To select all links, press CTRL + A.
  - Click Update Values.

Dealing with Broken Links
If the following message appears on your screen when you are attempting to update a linked file, this means that Excel cannot find the source file. This may be because the source file has been renamed or moved to a different location.

To reestablish the link between the two files:
  - Click the Edit Links option to open the Edit Links dialogue box.
  - Select the Change Source button from the Edit Links dialogue box.
  - This will allow you to navigate to the source file. Once you have located the source file, select it and click OK.

  - You will then see that the link has been reestablished (note OK showing under Status). Any updates of data should have been completed.
  - Click the Close button.
Unit 2 Practice Activity

1. Open Practice group sales.xls from the Practice Files folder.
2. Select the Total worksheet of the Practice group sales workbook.
3. In cells B5, B6 and B7 create 3D formulas to calculate a year total for each region.
4. Save the workbook as My group sales.
5. Copy cell B8 from the Total sheet.
7. Use the Paste Link option to link cell A1 to cell B8 from the Total sheet in My group sales.xls.
8. Save the new workbook as Mylink.
10. View the links in Mylink.xls.
11. Open My Group sales.xls from within Mylink.xls by using the Open source button.
12. Close both files.

Online support forum and knowledge base
http://www.microsofttraining.net/forum.php
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 3: Working with Dates

In this unit, you will learn how to:

- Insert and format dates
- Use dates in formulas
- Use date functions

Dates and time in Excel

Though Microsoft Excel displays dates and times as you would expect, it stores them as numbers.

Dates are stored as the number of days since the beginning of the last century (i.e. 1-Jan-1900 is day 1). Note that dates before 1900 are stored as text and cannot be used in calculations.

Times are stored as parts of a day – i.e. 12 noon is stored as 1/2 or 0.5. Both the date and time can therefore be stored as a single number, the fractional part forming the time.

When entering a date into a cell, Excel will accept various different formats (including year/month/day as well as day/month/year).

Months can be entered as a number or text - the name in full or in an abbreviated (three-letter) form. Years abbreviated to 2 figures are taken to be between 1930 and 2029 - i.e. 31/12/20 is 31-Dec-2020. If the year is omitted, the current year is assumed.

A slash or hyphen (minus sign) can be used to separate the day, month and year. Spaces can be used if the month appears as text.

If Excel recognises data as a date it will appear on the right of the cell - if it appears on the left, Excel hasn’t recognised it.

Times are entered into a cell by using a colon to separate the hour, minute and second. They also appear right-justified if recognised as valid. Because the time represents the fraction of the day, the hour must always be included. Times can be entered with an am/pm suffix if desired (a space must precede am/pm). Both a date and time (separated by a space) can be entered into a cell.
Inserting and formatting dates
Once a date and/or time has been entered into a cell, various format styles can be applied to the data.

To apply a format:

- Enter a date into an empty cell and press <Enter> - widen the column, if necessary
- Press <up arrow> to move back to the cell with the date
- Go to the Home tab, Number group
- Launch the Format Cells dialogue box

- On the Number tab select the Date Category:
- Select the desired date format from the Type: section
- Press <Enter> or click on [OK] to apply the chosen format

Entering date functions
There are numerous date and time functions in Excel 2010. These can be viewed by selecting the Formulas ribbon and clicking the Date & Time button from the Function Library group.

Two common functions are:-

=NOW()  Gives today’s date and time (e.g. 21/07/2005 09:30) - the two brackets are required.

=TODAY()  Gives today’s date in date format (e.g. 21/07/2005)

For a list and description of other Date and Time functions, please see the downloadable reference material.
Using dates in formulas
Because dates (and times) are stored as numbers, they can be used in calculations - for example, it's easy to work out the number of days between two dates or calculate an employee's wages given an hourly wage rate.

Some other tasks involving times and dates are less straightforward (for example, sorting dates into calendar order, irrespective of the year).

Date entries can also be used in formulae to give answers to your questions, e.g. working out a date which is 30 days from the present date.

<table>
<thead>
<tr>
<th>A</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>
Unit 3 Practice Activity

1. Open a new blank workbook and save as Practice Dates.
2. Type your date of birth into cell A1.
3. In cell A2, use a function to display today's date.
4. In cell A3, calculate how many days you have lived (a simple subtraction).
5. If necessary, format the result in cell A3 to read xxxxx days
6. Save the changes you have made to Practice Dates.xls and close the file.

Online support forum and knowledge base
http://www.microsofttraining.net/forum.php
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 4: Conditional Formulas and Formatting

In this unit, you will learn how to:
- Create IF functions
- Apply and work with conditional formatting in a spreadsheet

The IF function
Excel’s IF function can often prove to be very useful. You can use this function to branch to different values or actions depending on a specified condition. The structure of an IF function is as follows: IF (logical test, value if true, value if false)

IF functions are called conditional functions because the value that the function returns will depend on whether or not a specific condition is satisfied.

Let’s say that this next IF function is entered into cell B2: =IF(A1<=100,A1*.5,C3*2)

This function states that if the contents of cell A1 is less than or equal to 100, the value in cell B2 will be the value in A1 multiplied by .5; otherwise, the value in B2 will be the value of cell C3 multiplied by 2.

Using the Function Library
Excel 2010 contains an extensive library of functions that you can call upon to help you solve problems. These tools are available in the Function Library button group, on the Formulas ribbon.

The first and largest button is Insert Function. This button will open a dialog allowing you to search for and insert hundreds of functions.

You can also click the small fx button to the left of the formula bar to display the Insert Function box.

Clicking the Insert Function button activates the Insert Function dialogue box and provides access to the large range of functions available in Excel.
Once the Insert Function dialogue box is open:
- Select the function you wish to use from the available list and click OK or
- Type the name of the function you wish to use in the Search for a function area, press Enter, select the function when it appears in the list and click OK.

**Manually entering a function**
If you know which function you wish to use, you can enter a function into a worksheet by inputting it manually (i.e. by typing the function directly into a cell).

For example, if you type =IF into a cell the following appears.

```
=IF
```

If there is more than one function listed, you can toggle between them by using the arrow up or arrow down keys.

Once you have selected the function you wish to use, continue by typing in a left bracket, (double clicking the function name will add the opening bracket) which will cause the function syntax to display in another screen tip.

```
=IF
```

Continue to enter all the arguments required for the function to give you a result, and make sure to type a comma between each argument.

```
=IF(A1<=100, A1^+.5, C3^2)
```

Press Enter to display the result.
Conditional Formatting
In Excel 2010 you can design a worksheet in such a way that data is formatted differently, based on the values the data assume at any given time. This is called conditional formatting.

Applying Conditional Formatting
To use conditional formatting:
- Select a range of data that you want to apply the formatting to.
- On the Home ribbon, Styles group, click the Conditional Formatting button.

- This will display a menu of conditional formatting options. From this menu, you can choose:

<table>
<thead>
<tr>
<th>Highlight Cells Rules</th>
<th>This will highlight cells that are greater than, less than, between or equal to values that you can specify.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom Rules</td>
<td>This option will allow you to highlight the top or bottom numbers or percent in the selected cells.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Will display coloured bars that are indicative of the value in the cell. This is what is used in the image above.</td>
</tr>
<tr>
<td>Colour Scales</td>
<td>Will use different shades of colour to represent different values, from low to high.</td>
</tr>
<tr>
<td>Icon Sets</td>
<td>Will use sets of similar icons that will visually indicate a cell’s value.</td>
</tr>
</tbody>
</table>

- Select the option you wish to use to apply formatting.
Creating a Conditional Formatting Rule
If you click the New Rule option near the bottom of the conditional formatting menu, you will display the following New Formatting Rule dialogue box.

In this dialogue box you can configure more precise and specific conditional formatting rules. The options in the Edit the Rule Description panel will change as you click the different items in the Select a Rule Type panel.

Removing Conditional Formatting
If you want to remove conditional formatting rules, simply use the Clear Rules option from the menu. This option will let you clear rules for selected cells or for an entire spreadsheet.

Using the Manage Rules Option
The Manage Rules option will allow you to delete, edit, or add new conditional formatting rules.
Unit 4 Practice Activity

1. Open the file Commission.xls from the Practice Files folder.

2. Select the IF function sheet.

3. Create an IF function in cell G7 which will calculate a salesperson's commission based on their Total sales (column F). If the person's Total sales are greater than 20,000 then they receive a commission of 5.5% of their total sales; otherwise, they receive no commission. Use the cells J5 and J6 as part of your formula, and remember to make them absolute ($)

4. Copy the formula to the remainder of column G to view commission for all Sales Representatives.

5. Format the function results with currency, a comma separator and two decimal places.


7. Select the range B7:E41.

8. Apply conditional formatting to the selected range to show values in excess of or equal to £6,500 in Blue (either font or shading) and values equal to or less than £5,500 in Yellow (either font or shading).

9. Remove all conditional formatting from the spreadsheet.

Online support forum and knowledge base

http://www.microsofttraining.net/forum.php

Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 5: Working with Tables

In this unit, you will learn how to:
- Create and change a table range in Excel
- Sort table data
- Filter table data
- Create subtotals

What is a Table?
In Excel 2010, a table is a specially designated range of numbers. This special range of numbers has added functionality that other cell ranges do not have. You can have more than one table in a workbook or worksheet if you want, and tables can be as large or small as the amount of data you want to work with.

Normally a table is made from adjacent columns of data, with a unique label or heading for each column. Each row in the table should have entries organised according to the column headings. You should keep your table data adjacent in a block to take advantage of all of Excel's table features. Some Excel features, like filters and PivotTables, will not work correctly if the data is not blocked together in adjacent columns as a table.

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
<th>Branch</th>
<th>Account</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bob</td>
<td>1st</td>
<td>B1112220</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>2</td>
<td>Janet</td>
<td>2nd</td>
<td>B1112221</td>
<td>$120,000.00</td>
</tr>
<tr>
<td>3</td>
<td>Mike</td>
<td>3rd</td>
<td>B1112223</td>
<td>$(2,000.00)</td>
</tr>
<tr>
<td>4</td>
<td>Claire</td>
<td>1st</td>
<td>B1112222</td>
<td>$18,000.00</td>
</tr>
<tr>
<td>5</td>
<td>Veronica</td>
<td>2nd</td>
<td>B1112224</td>
<td>$55,000.00</td>
</tr>
<tr>
<td>6</td>
<td>Sandy</td>
<td>3rd</td>
<td>B1112225</td>
<td>$15,670.00</td>
</tr>
<tr>
<td>7</td>
<td>Art</td>
<td>1st</td>
<td>B1112226</td>
<td>$23,000.00</td>
</tr>
<tr>
<td>8</td>
<td>Reggie</td>
<td>2nd</td>
<td>B1112227</td>
<td>$5,600.00</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating Tables
To create a table from an existing range:
- Pre-select a range of data in adjacent columns or click any cell within the required data range
- On the Home Ribbon, Style group, click on the Format as Table button.

This will display a menu of table formatting options. If you click on one of the table menu options, the selected range will be formatted as a table based on the style of your choice.
- When you choose a table format, you will see a Format as Table dialogue box appear.

- If there are column headings in the first row of the range you selected for your table, check the box that says, “My table has headers.”
- Make sure the cell range shown is the range that you want for your table;
- Click the OK button to create your table.

Changing the Table Range
To change the table range – method 1:
- Use the small blue move handle in the bottom right corner of the table.
- Position your mouse on top of the move handle, then hold down your left mouse button and drag the move handle to resize the table.

<table>
<thead>
<tr>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data1</td>
<td>Data2</td>
<td>Data3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>300</td>
<td>34</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>233</td>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>360</td>
<td>233</td>
<td>67</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>490</td>
<td>2</td>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>620</td>
<td>-229</td>
<td>-21</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>750</td>
<td>-460</td>
<td>-65</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>880</td>
<td>-691</td>
<td>-109</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To change the table range – method 2:

- Click on a cell in your table
- The contextual **Design** tab appears above the ribbon area of the screen. This contains options for working with your table.

  - In the **Properties** group, click **Resize Table** button.
  - The Resize Table dialogue will appear on your screen.
  - Select the new table range with your mouse.
  - Click OK and your table will be resized.

---

**Inserting Table Columns**

To add a column to the table:

- **Right click** on a cell in the column next to where you want to insert a new column.
- From the menu, choose **Insert**, and then **Table columns to the Left**, or **Table columns to the Right**.

You can also quickly add additional columns to your table by clicking a cell to the immediate right of the table and then entering data into the cell.

---

**Inserting Table Rows**

To add rows to the table:

- **Right click** on a cell in the row below where you want to insert.
- Choose **Insert** from the menu, and then choose **Table Rows Above** from the submenu.
You can quickly add a new row to the end of a table by clicking on a cell immediately below the table and entering data into it. The new row will automatically be included in the table range when you press the Enter key after typing your data into the cell.

Deleting Rows or Columns
To delete a row from your table:
- Right click on a cell in the row that you want to remove
- Select Delete, and then choose the Table Rows option.

To delete a column from a table:
- Right click on a cell in the column that you want to remove
- Select Delete, followed by Table Columns, from the menus.

Creating a Table Total Row
If you are working with a table in Excel 2010 and you click on a table cell, a contextual Table Tools tab should appear containing a Design ribbon.

- Select the Design Ribbon
- In the Table Style Options group, check the box labeled Total Row.

  ![Table Style Options]

- This will display another row at the bottom of the table, with the word Total in the first cell.
- Select a cell in the Totals Row and a drop-down arrow will appear.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>620</td>
<td>-229</td>
<td>-21</td>
</tr>
<tr>
<td>750</td>
<td>-460</td>
<td>-65</td>
</tr>
<tr>
<td>880</td>
<td>-691</td>
<td>-109</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>-26</td>
</tr>
</tbody>
</table>

- Choose a function type from the drop-down list to apply to the particular column of data.

If you drag the move handle to lengthen the table, the Total Row will stay at the bottom.

If you enter any new data into the table the values in the Total Row cells will be recalculated accordingly.

If you want to change what is displayed in the Total Row, you can click on any cell in the row and choose another option from the drop-down list.

You can hide the Total Row by:
- Clearing the Total Row checkbox on the Design Ribbon, Table Style Options group;
- or
- Right click a cell in the table and select Tables then Totals Row.
Sorting and Filtering Tables
Excel tables are intended to help users manage, maintain, find, and retrieve data. This includes sorting a table, working with AutoFilters, custom AutoFilters, and advanced filters.

Sorting Data in a Table
To sort a table:

- Choose a column that you want to sort by
- Click on the AutoFilter arrow at the top of the column. If you cannot see the AutoFilter arrows, select a column heading in your table and then click the Filter button on the Data Ribbon.
- Clicking the AutoFilter arrow will display a drop-down list of options for filtering your records.
- Select Sort Smallest to Largest or Sort Largest to Smallest.
You can also sort your table by clicking on a cell in the table and then clicking the **Sort** button on the **Data** Ribbon.

This will display the Sort dialogue.

With the Sort dialogue box:
- Select a column to sort from the Sort by drop-down list
- Choose a quality of the given column to sort on (i.e. value, cell colour, or font colour)
- You can then choose the order of the sort.
- Click the Add Level button and create a Then By sorting rule.
- Repeat the above steps if you wish to create additional sorting rules
- When you finish configuring the Sort by dialogue box, click OK
What is an AutoFilter?
An AutoFilter is an Excel feature that lets you filter out rows from a data table. You can select an AutoFilter option and only rows that meet the specified criteria will be shown.

To apply an AutoFilter:
- Click the AutoFilter arrow next to the column heading that contains the criteria you wish to display in the filtered data.
- When you display the AutoFilter drop-down list, you will see the corresponding column values from your data table in ascending order. Remove the checkmarks next to the items you wish to remove from the filter.

To remove an AutoFilter:
- Look for the filter symbol on the AutoFilter drop-down arrow next to the column headings – these indicate the column/s that filters have been applied to
- Click any drop-down arrows showing the filter symbol and select Clear Filter from [Column name]

Custom AutoFilters
With the custom AutoFilter options, you will be able to set up a customised filter for your data table.

To create a custom AutoFilter:
- Select a column heading that you want to filter
- Choose Custom Filter from the AutoFilter drop-down arrow
- This will open the Custom AutoFilter dialogue box.

In this dialogue, you can use the drop down arrows and radio buttons to set up filtering criteria for the rows in your table.

The first drop-down list, with the default value Equals, will display the following expressions that you can choose from to create a filter.

- Equals
- Does not equal
- Is greater than
- Is greater than or equal to
- Is less than
- Is less than or equal to
- Begins with
- Does not begin with
- Ends with
- Does not end with
- Contains
- Does not contain
The next drop-down list (on the immediate right) will contain values from your data table belonging to the column you are filtering.

You can select the ‘And’ radio button or the ‘Or’ radio button to incorporate additional criteria into your filter. The two drop-down lists here are the same as the first two.

When you use the ‘And/Or’ radio buttons to build custom filters, remember:

- For the ‘And’ option, both conditions (A and B) must be satisfied for a row to be shown.
- With the ‘Or’ option, rows that satisfy either condition will be shown.

You can use the radio buttons to combine filtering conditions, or just filter based on options from the first two drop-down lists.

### Removing Filters

To remove a custom filter:

- Look for the filter symbol on the AutoFilter drop-down arrow next to the column headings – these indicate the column/s that filters have been applied to.
- Click any drop-down arrows showing the filter symbol and select Clear Filter from [Column name]

Alternatively:

- Select a cell within the table range.
- On the Data tab, Sort & Filter group, click the Clear button. All table data is then restored.

### Filtering with Wildcard Characters

In Excel, you can use the question mark (?) or the asterisk (*) as wildcard characters. A question mark will substitute a single character in a string, while an asterisk can substitute multiple characters in a string. For example, the string “ca?” could be car, cat, can, cap, and so on. The string “tele*” could be television, teleportation, telemarketing, and so on.

To see how to use these wildcard characters in a filter, please see the downloadable reference material.
Using an Advanced Filter

If you can’t get the results you want from a custom filter, you can construct your own advanced filters to get the most control over your data tables.

To make an advanced filter, you have to set up a range of criteria to filter your table with.

Criteria will consist of the column field heading or headings you are wanting to filter from; and the criteria parameters you wish to filter for these fields entered directly underneath the column heading/s.

Criteria should be entered before creating the advanced filter.

To create an advanced filter:

- Select any cell in the main data table.
- Select the Data ribbon, from the Sort and Filter group click the Advanced button.
- If you wish to filter within the current database, ensure that the Filter the list, in-place option is selected in the Action area.
- If you wish to create a copy of the filter results to be displayed separately from the table, choose the Copy to Another Location option and click an empty cell with sufficient space below and to the right to allow for the placement of the filtered data. The location must be located on the same sheet as the data table.
- In the List Range box, select or enter the cell references for the table.
- In the Criteria Range box, select or enter the cell references for the criteria range.
- To ensure that only one record is displayed, if some contain exactly the same data, turn on the Unique Records Only check box.
- Click OK. Data in rows not matching the criteria set will be hidden.

To display the full table again, click the Clear button in the Sort & Filter group on the Data Ribbon.
Creating Subtotals

Another kind of outlining or grouping technique available in Excel is the subtotals feature. If you have numeric data organised with clear column and row headings, you can use Excel to create automatic subtotals and grand totals for the data.

To use Excel's subtotal feature:
1. The first step you must take is to sort the column which will be used in step 4 in ascending order.
2. The select the range of data you want to apply subtotals to
3. Select the Data Ribbon, Outline group and click the Subtotal button.
4. The drop-down list under the “At each change in” heading gives you the option to select where the subtotals will be inserted within your selected range (the sorted column). Totals will be applied every time the values under the chosen column label changes.
5. The “Use function” drop-down list lets you choose which function to apply to your data. The function you choose (normally SUM) will be used to calculate the totals.
6. Under the “Add subtotals to” option list, you can select which columns to apply the totals to. You can apply totals to a single column or to multiple columns in the selected range.

Finally, there are three check boxes at the bottom of the dialogue box that will allow you to:
- Replace any pre existing subtotals
- Put page breaks between totaled groups so they will be printed on separate pages
- Place the subtotals and grand totals above or below the corresponding data

To remove subtotals
- Select the range of data
- Select the Data Ribbon, Outline group and click the Subtotal button.
- Click the Remove All button.
Unit 5 Practice Activity

1. Open Practice Employee.xls from the Practice Files folder
2. Format the data as a table, which includes all column headings and associated data.
3. Add a new row to the table, containing the following employee details:
   Pam Stockwell 999 Pierhurst N Sacramento Finance 13456
4. Sort by Last Name in ascending order.
5. Sort first by City in descending order, then by LastName in ascending order.
6. Use the AutoFilter to display only those records for the residents of San Diego. Then, display all records again.
7. Display only those records for San Diego or Riverdale. Then, display all records again.
8. Create a filtered list to display only those records where the Salary level is greater than 12000 and less than 23500. Then sort the filter results in ascending order of Salary.
9. Remove the filter.
10. Create a Totals Row for the table which displays a total for the Salary column.
11. Save the workbook as My Practice Employee and close.

Online support forum and knowledge base
http://www.microsofttraining.net/forum.php
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 6: Documenting and Auditing

In this unit, you will learn how to:

- Work with comments in a spreadsheet
- Trace errors in a formula
- Apply protection to all or part of a worksheet

Comments
Annotating a spreadsheet is a good idea if you intend on sharing it with other users. Your notes will help the people you share your spreadsheet with understand what is going on.

Adding, editing and deleting comments
The Comments group can be found on the Reviewing tab.

The New Comment button can be used to add a comment to your spreadsheet. You can delete a selected comment with the Delete button, or move between comments with the Previous and Next buttons.

The Show/Hide Comment button will show or hide the comment associated with the currently selected cell. The Show All Comments button will show all of the comments that have been added to the spreadsheet.

The Formula Auditing Group
The Formula Auditing group can be found on the Formulas ribbon. This group of buttons can help you trace errors and show the cells that are referenced in a formula.

The Trace Precedents button will display blue arrows to cells that supply data to the formula. Arrows may be red if a supplying cell has an error.

The Trace Dependents button will display arrows to the other cells that depend on a given cell's data.

The Remove Arrows button will remove both precedence and dependence arrows from your Excel screen.

The Show Formulas button will toggle between showing results and formulas in the worksheet. You can also use the Ctrl + ‘pipe’ key shortcut keys to do the same thing.

The Error Checking option will check the entire worksheet for formula errors. If any are found, you will be alerted with an error checking dialogue (like the one below) that pertains to the specific error in question.
You can also click the down arrow next to the Error Checking button to see additional options.

The first option (Error Checking) will perform the same action as if you clicked the Error Checking button directly. The Trace Error option will display arrows to the cells referenced in an incorrect formula. The Circular References menu will display cells that contain circular references, if there are any in the worksheet.

The Evaluate Formula dialog will help you analyse, interpret, and correct formulas.

Last but not least, the Watch Window button will display the watch window dialogue (shown below). You can use this dialogue to watch a cell or selection of cells (perhaps from another worksheet) while you make changes to the data in another area.

If you find that your formula just isn’t producing the correct results, try the formula auditing buttons. These features can help you fix formula mistakes by checking your worksheet for errors and tracing cell dependencies so you can see all of the cells that are referenced in a formula.

For further information on troubleshooting the possible causes of formula errors, please see the downloadable reference material.
Excel Workbook and Worksheet Protection

The information in your Excel workbooks can be very important; and may contain crucial data that must not be modified or altered in any way, intentionally or otherwise. Protection allows you to control what users can and can’t edit in a spreadsheet.

Protecting your Worksheets

Excel 2010 allows you to protect your data on a worksheet by worksheet basis. This feature is useful for situations where users are permitted or required to modify data on one worksheet, but are forbidden to modify data in another worksheet in the same workbook.

To protect a worksheet:

- Select the **Review** tab, **Changes** group and click the **Protect Sheet** button.
- In the dialogue box, you will notice a series of checkboxes. Users will be able to perform any tasks that you select with checkmarks, and they will not be able to perform any tasks that are not checked.
- After you set up the tasks that you will allow users to perform, enter a password in the Protect Sheet dialogue and click OK.
- When you enter a password and click OK, Excel will ask you to re-enter the password to confirm it.
- If you re-enter the password correctly and then click the OK button, the worksheet will be protected.

To unprotect the worksheet

- Select the **Review** tab, **Changes** group and click the **Unprotect Sheet** button.
- Enter the correct password to unprotect the sheet.

Unlocking Cells

If you want to prevent users from modifying the actual cell data in your worksheets, your cells must be locked and the worksheet must be protected. In Excel the cells are locked by default, so when you protect a worksheet, the cell data can no longer be modified. If you want users to be able to modify the data in some cells, you must unlock the cells that you want to be editable before you protect the worksheet.

To unlock cells in a worksheet

- Select the cells that you want to unlock.
- Select the **Home** tab, **Font** group and click the small arrow at the lower right of the Font group.
  
  ![Font group screenshot]

- When you see the Format Cells dialogue appear, click the **Protection** tab.
- Clear the checkmark from the checkbox labeled **Locked**, and click OK. The cells you selected will now be unlocked.
- When you protect the worksheet with the Protect Sheet button on the Review Ribbon, the cells that you selected and unlocked will be editable. This means that users can modify the cells that you unlocked, but they can do nothing to the data in the other cells in the sheet.

For information on protecting an entire Excel workbook, and creating a password to open an Excel file, please refer to the downloadable reference material.
Unit 6 Practice Activity

1. Open the file **Sales analysis.xls** from the **Practice Files** folder.
2. Locate the cell showing a formula error in the spreadsheet.
3. To trace the error:
   - Select the cell showing the error.
   - Go to the **Formulas** ribbon, **Formula Auditing** group, click the **Error Checking** button. Close the dialogue box then use **Trace Error**.
   - The arrows show which values are used to make the calculation in the cell you have selected.
4. Using the arrows showing on screen to assist you, determine what is causing the error in the formula and edit the formula to resolve the error.
5. Insert a comment displaying the text 'Error fixed' in the cell previously showing the error.
6. Remove the arrows from the spreadsheet.
7. Protect the sheet with a password, and check that protection has been applied.
8. Save the file as **My Sales analysis** and close.

**Online support forum and knowledge base**


*Visit our forum to have your questions answered by our Microsoft certified trainers.*
Unit 7: Using Templates

In this unit, you will learn how to:

- Access and use Excel’s in-built templates
- Create, modify and use custom templates

What is a Template?
A template is a workbook design or layout that can be saved and reused for any number of workbooks. A template can have formulas, formats, and a host of other Excel features that will be applied to each new workbook that uses the template.

Creating a Workbook from a Template
To open a workbook from a template:

- Select New from the File tab menu.
- Select a template grouping from the categories listed in the panel on the left.
  - Select Installed templates to view inbuilt templates;
  - Select New from Existing to browse for other template files.
  - Select My Templates to view templates saved on the Templates folder on your own hard-drive
- Select the required template file and click Create.

Creating a Template
To create your own template, open Excel 2010 and design your worksheet or workbook layout to meet any specifications you require. You can add labels, formatting, colour, borders, and formulas. If need be, you can even create layouts on different sheets in the workbook, as a template can contain as many worksheets as you need.

Remember, the main purpose of a template is for repeated use of a workbook layout. Keep this in mind when creating a template. Plan your layout, labels, and formats to make your templates comprehensive and complete.

When you have completed your design:

- Choose Save As from the File tab menu
- In the dialogue, enter a name for your template in the File Name text field.
- Display the Save As Type drop-down list near the bottom of the dialogue box
- Select the Excel template option. (You may have to scroll through the list of options to find it). This will save the file as filename.xlsx.
- New templates will be automatically saved in the Excel Templates folder. You can choose another folder to save your templates in if you wish, but if you do, you will need to choose the New from Existing option when creating files from the template.
Unit 7 Practice Activity

1. Open Practice Group Sales 2.xls from the Practice Files folder
2. Copy the qtr1 sheet to another workbook, and close Practice Group Sales 2.xls.
3. Edit the copied sheet so it could be reused to enter figures for each quarter.
4. Save the file as a template named Quarterly Sales template.

Online support forum and knowledge base
http://www.microsofttraining.net/forum.php Visit our forum to have your questions answered by our Microsoft certified trainers.